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Foreword

This manual contains installation and operation information for the Zebra P110i and P110m
card printers manufactured by Zebra Technologies Corporation.

The only difference between these modelsis that the P110i supports full-color ribbons (which
may include a protective overcoat panel), and the P110m supports monochrome color printing
only. Photographs and drawings that show the front facepl ate show the P110i name; for P110m
printers these would show P110m.

In this manual, references that are specific to the P110i or P110mwill be identified as such;
references that apply to both models will use the term “the printer.”

Copyright Notice
© 2005, 2006, 2007 ZIH Corp.

This document contains information proprietary to Zebra Technologies Corporation. This
document and the information contained within is Copyrighted by Zebra Technologies
Corporation and may not be duplicated in full or in part by any person without written
approval from Zebra Technologies Corporation. While every effort has been made to keep the
information contained within current and accurate as of the date of publication, no guaranteeis
given that the document is error-free or that it is accurate with regard to any specification.
Zebra Technologies Corporation reserves the right to make changes, for the purpose of product
improvement, at any time.

Trademarks

P110i and P110m are trademarks and Zebrais a registered trademark of Zebra Technologies
Corporation. Windows is aregistered trademark of Microsoft Corp. All other trademarks or
registered trademarks are marks of their respective holders.
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Foreword

Product Disposal

%

Product Disposal Information ¢ Do not dispose of this product in unsorted municipal
waste. This product is recyclable, and should be recycled according to your local
standards. For more information, please see our web site at:
http://www.zebra.com/environment

Return Materials Authorization

Before returning any equipment to Zebra Technologies Corporation for in-warranty or out-of-
warranty repair, contact Repair Administration for a Return Materials Authorization (RMA)
number. Repack the equipment in the original packing material and mark the RMA number
clearly on the outside. Ship the equipment, freight prepaid, to the address listed bel ow:

For USA, Latin America, and Asia/ Pacific: For Europe and Middle East:
Zebra Technol ogies Corporation Zebra Technol ogies Corporation
Zebra Card Printer Solutions Zebra Card Printer Solutions
1001 Flynn Road Pittman Way, Fulwood
Camarillo, CA. 93012-8706.USA Preston, PR2 92D
Phone: +1 (805) 578-5001 Lancashire, U.K.
FAX: +1 (805) 579-1808 Phone: +44 - 1 - 772 - 797555

FAX: +44 -1 - 772 - 693000

Declarations of Conformity

FCC Regulations

Models P110i and P110m have been tested and found to comply with the limitsfor aClass A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercia environment. This egquipment generates, uses, and can radiate radio frequency
energy and, if not installed and operated in accordance with the P110i and P110m User’s
Manual, may cause harmful interference to radio communications. Operation of this
equipment in aresidential areais likely to cause harmful interference in which case the user
will be required to correct the interference at his own expense.

Pursuant to Part 15.21 of the FCC Rules, any changes or maodifications to this equipment not
expressly approved by Zebramay cause harmful interference and void the FCC authorization
to operate this equipment.
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Industry Canada Notice

C€

Foreword

This device complies with Industry Canada ICES-003 class A requirements.

Cet équipement est conforme al 'ICES-003 classe A de laNorme Industrielle Canadienne.

EMC Directive EN 55022 RF Emissions control
89/336/EEC (1998)
modified by Lo EN 301489-3 RF Emissions and Immunity for
92/31/EEC and EMC Directive V14.1 radio eguipment
93/68/EEC o EN55024 Immunity to Electro-Magnetic
EMC Directive | 5001 Disturbances
73/23/EEC
modified by 93/ 'E)ﬂ"éc‘t’?\'/teage 252%0?())950-1 Product safety
68/EEC
R&TTE EN300330-2 ,
1999/5/CE Directive V111 Radio Freguency Interferences

For aformal certificate, please contact the Compliance Office at Zebra's Camarillo facility.

EUROPE: Norway Only: This product is also designed for IT power system with phase to phase

voltage 230V. Earth grounding is via the polarized, 3-wire power cord.
FlI: “Laite on liitettdva suojamaadoitus koskettimilla varustettuun pistorasiaan”

SE: “ Apparaten skall anslutastill jordat uttag”
NO: “Apparatet matilkoples jordet stikkontakt”

980515-001 Rev. C
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Foreword

Ilcons

Throughout this manual, different icons highlight important information, as follows:

Note « Indicates information that emphasizes or supplements important points of the main
text.

(3

Advises you of information that is essential to complete atask, or points out the importance
of specific information in the text.

=

Electric Shock Caution « Warns you of a potential electric shock situation.

>

Electrostatic Discharge Caution « Warns you of a situation where electrostatic
discharge could cause damage to electronic components.

Caution ¢ Advises you that failure to take or avoid a specific action could result in
physical harm to you, or could result in physical damage to the hardware.

> P
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Printer Models
The Zebra Product Number tells a story:

Foreword

Hereisaquick review of the Zebra Card Printer Series numbering and lettering system to help

you.

Model numbers include identifiers that specify options using the following lettering

conventions:

Part Number

Description

P110
P110m

Base Printer
P110i Single Sided Color Card Printer
P110m Single Sided Monochrome Card Printer

Smart Card Options
None

Magnetic Encoder
None
Yes (select defaults below)

Magnetic Encoder Defaults
None
Stripe Down, HiCo/LoCo

Memory Expansion
None

Interface
USB Only
USB and Ethernet

Power Cords
U. S. and Europe
U. K. and Austraia

Windows Drivers and User Documentation included on one CD
(Software & Documentation Package) which contains Multi-
language documentation - English, Spanish, French, German,
Chinese, Italian, and Portuguese

Example
P11O0i

Starter Kit
No Starter Kit
Starter kit (including 200 - 30 mil PVC cards and one
YMCKO ribbon, part number 800015-940) (P110i only)

P110i Single-Sided Color Card Printer, Magnetic Stripe Encoder
(HiCoDn), Standard Memory, USB Inter-face, US and Europe
Power Cords, Windows Driver and User Documentation CD

Accessories

105862-001

P120i/110i/P110m Card Sense™ single card feed upgrade kit

105912-912

P120i/110i/P110m Cleaning Kit, includes 4 print engine cleaning
cards and 4 feeder cleaning cards

980515-001 Rev. C
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Getting Started

Unpacking Your Card Printer

Your P110i or P110m printer shipsin a cardboard carton, protected by styrofoam inserts
and a protective anti-static bag. Keep all packaging material in case you need to move or
re-ship the printer.

1. Before opening and unpacking the printer, inspect the carton to ensure that no damage
occurred during shipment.

2. Ensure that you have aclean and nearly dust free environment for proper operation
and storage of the printer.

3. Unlatch and remove the handle, open the carton, and remove the box containing the
printer accessories from the shipping carton.

4. Remove the styrofoam packing material from the top of the printer.

5. Lift the printer out of the carton by holding it on both sides of the bottom and lifting
the printer gently from the carton.

6. Make sure the following accessories are included with your printer:
Software CD-ROM

Quick Start Guide

Cleaning Kit

120 VAC and 230 VAC Power Cords
Power Transformer

USB Printer Cable

-0 20 T

If any items are missing, please contact your dealer. To reorder; refer to Appendix D of
this manual.

980515-001 Rev. C P110i & P110m Card Printer User’s Manual 1



Getting Started

Controls and Indicators

Multi-Function LCD Panel

Your printer is equipped with aMulti Function LCD Readout Panel to provide printer status
information. The readout is controlled by the multi-function control button directly below the
viewing window.

Multi-Function
LCD Panel

Multi-Function
Control Button

('
@@%
=3 Zebra

P110i

The LCD Panel can display the following messages:

Message Mode
Operational
Initializing Fixed
SELF TEST Fixed
READY Fixed
DOWNLOADING DATA Fixed
MAG ENCODING Fixed
PRINTING MONO Fixed

PRINTING CYAN

PRINTING YELLOW Fixed (These
messages do not

PRINTING MAGENTA apply to the P110m

PRINTING BLACK Printer.)

PRINTING OVERLAY

DOWNLOADING FIRMWARE Fixed

2 P110i & P110m Card Printer User’s Manual 980515-001 Rev. C
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Getting Started

Message Mode
CLEANING Fixed
REMOVE RIBBON THEN CLOSE LID Scrolling
EMPTY FEEDER THEN CLOSE COVER Scrolling
FEED LONG CLEANING CARD IN EXIT Scrolling
REMOVE LONG CLEANING CARD Scrolling
INSERT FEEDER CLEANING CARD Scrolling
CLOSE FEEDER DOOR Scrolling
REMOVE FEEDER CLEANING CARD Scrolling
SINGLE CARD READY-PRINT OR EJECT Scrolling
INSERT CARD Fixed
PUSH BUTTON TO CONTINUE Scrolling
Warnings (Printer will still operate)
REMOVE CARD AT EXIT Scrolling
CLEAN PRINTER Fixed
CHECKING RIBBON Fixed
ENCODING ERROR Fixed
INVALID MAGNETIC DATA Scrolling
CHECK RIBBON Fixed
CLOSE LID Fixed
FLASH ERROR Fixed
READING ERROR Fixed
Errors (Printer will not operate)

OUT OF RIBBON Fixed
OUT OF CARDS Fixed
MECHANICAL ERROR Fixed
COVER OPEN Fixed
PARAMETERS ERROR Fixed
COMMAND ERROR Fixed
LID OPEN Fixed
OUT OF RIBBON Fixed

P110i & P110m Card Printer User’s Manual



Getting Started

Rear Panel Connectors, Controls, and Indicators
The figure below shows the rear of the P110i or P110m Printer.

Power

j: T Socket

usB
Port

4

Power
Switch

Power Switch

The power switch is located at the rear of the printer unit, bottom right.

Power Socket

The power socket islocated at the rear of the printer, to the left of the power switch.

USB Port

The USB port islocated at the rear of the printer unit, bottom left.
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Getting Started

Ethernet Option

If your Printer includes the Ethernet option, the rear of the printer will look like the figure
below.

Power

j: :t Socket

UsB
Port
& & [l
Power
Vil Switch
| IS E—
Network Ethernet Ethernet Ethernet
Status / Adapter Reset Connector
Activity Status Button
Indicator Indicator
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Printer Installation

Installing the P110i or P110m Printer

time. THE DRIVER WILL PROMPT YOU WHEN IT IS TIME TO PLUG IN AND POWER

Caution « Do not power the printer with USB attached to your computer at this
A UP YOUR PRINTER.

Caution « Limit electrical power supplied to the P110i or P110m Printer to 24
VDC. Limit excess current draw to 16 amps or less, using an associated circuit
breaker or other such device. Never operate the printer in a location where

A operator, computer, or printer can get wet. Personal injury could result. The
printer must be connected to an earthed electrical power supply and properly
protected against electrical surges and grounding faults. The power supply pack
can only be replaced by the same product from the manufacturer.

980515-001 Rev. C P110i & P110m Card Printer User’s Manual 7



Printer Installation

1. Placethe printer in alocation that allows easy accessto all sides. The printer should never

be operated while resting on its side or upside down

2. Remove theyellow CAUTION label from the back of the printer.

3. Ensure that the printer’s power switch isin the OFF (O) position.

@[

ad

-

7)
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Printer Installation

4. Insert the power supply plug into the power socket, attach the power cord (120VAC or
230VAC) to the power supply, then plug the power cord in to agrounded el ectrical socket

of the proper voltage and type.

[ ] { I 1]/ 115 VAC

230 VAC
/%EH

Caution « Intermittent or unpredictable operation may occur from unsecured

A connectors. If damaged, the power cable must be replaced by an exact equivalent. The
socket should always be easily accessible to power off the printer.

5. If your printer has only the USB interface, attach the included USB cable to your
computer and the printer.

o
o
o
o3
(o}
9}
C
c

SO0
el
85808968535

o o0

OO0

B
SEERREEEES
O—~O~0O~ OO
ORI

o]
PR0IEL0
=X
e)
o S0
S50

I
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Printer Installation

6. If your printer has the optional Ethernet interface (as well asthe USB interface), connect
either the USB cable to printer and computer or the Ethernet cable to the printer and the
Ethernet network.

Important « Do not connect both the USB and the Ethernet interfaces at the same time!

9,
o
SSSRS!

e
RSORS

Q
o]
o]
O

K
o)

o 1

©
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Printer Installation

Installing the Printer Driver

driver will prompt you when it istime to plug in and power up your printer.

Important « Do not power the printer with USB attached to your computer at thistime. The

To install the Printer Driver on Windows 2000 and Windows X P operating systems, insert the
User Documentation and Drivers CD, included with your printer, into your computer and the
InstallWizard will walk you through the required installation steps.

Both the P110i and P110m Printers use the same Printer Driver.
The InstallWizard will:

980515-001 Rev. C

Automatically install the User Interface when the driver CD isinserted.

Start the installation process when the I nstall Printer Driver menu itemis selected from
the Main Menu.

Allow you to install Ethernet drivers, if you plan on networking your card printer viaan
external print server

Check to see which operating system you are using

Detect previous versions of the driver and clean up any unnecessary Windows registry
entries. You must select “Remove” from theinstall options to remove any previous driver
versions.

Install the new driver files
Reboot your computer

P110i & P110m Card Printer User’s Manual 11
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Printer Installation

Print Driver Installation

Install the Printer driver asfollows:

Card

(& L Printer
a5 Solutions

Please Select Language

il

=l

1. Insert the P110i / P120i / P110m User Documentation and Drivers CD into the CD drive
of the host computer. The Select L anguage window will open.

2. Fromthe Select L anguage window, choose the appropriate language for your system. The
Main Menu will open in the selected language.

@% Value Line
oV Zebra P110./ P110m. / P120;
Printer Driver Documentation ~ Support
View README >> View CD README >> Register Your Product **
>> lr:;l;gu P110m >> Warranty Media List *
S P >> Ethernet FAQ >> P110i
Install Printer Driver User's Manual * :: ;:;g:"
>>P110i, P110m >> P110i, P110m
>> P120i >> P120i >> Web Site **
>> [nstall Adobe Acrobat
>> [nstall ZebraNet Utilities
* Requires Acrobat : 1 '
** Requires active internet connection

P110i & P110m Card Printer User’s Manual
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Printer Installation

3. From the Main Menu, under Install Printer Driver, select P110i / P110m.

S Note « Note that the Driver installer will refer to the P110i. Remember, the same driver is
used for both the P110i and P110m Printers.

Card Printer Solutions
® Cord Frinter Drivers

InstallShield Wizard

Zebra P110i Card Printer Setup iz preparing the Installs hield
i Wizard, which will guide you through the program setup process.
* Pleaze wait.

Configuring *indows Installer

[(WERN ] | Cancel |

4. TheInstallShield Wizard will be installed and a progress window will be displayed. Once
the Install Shield Wizard has been installed, the Welcome to I nstallShield Wizard
window will open.

Zebra P110i Card Printer 4.10.01

Welcome to the InstallShicld Wizard for Zebra P110i Card Printer

will Zebra P110i Card Printer on your computer. To confinus,

Instad|Siield ! [ cpack [ [Heaz) [

5. Onthe Welcometo InstallShield Wizar d window, click the Next button.

980515-001 Rev. C P110i & P110m Card Printer User’s Manual 13



Printer Installation

Zebra P110i Card Printer 4.10.01

g Inztall etharnet finternal] printee drivers,

InstallSiiid | rr[ < Back H Newt> | N

6. Select USB or Ethernet, click the Next button, then follow the instructions that appear on
the screen.

7. When driver installation is complete, you will be prompted to restart your computer.

Change Printer Driver Options

= Note « The screen shots shown in this section are for the P110i Printer using the USB
interface. If you are using the Ethernet interface, the screenswill refer to the * Zebra P110i
Network Printer.” Again, remember that the P110m Printer uses the same driver.

14 P110i & P110m Card Printer User’s Manual 980515-001 Rev. C



Printer Installation

You can change the default settings for the printer driver. Change the options as follows:

1. Select Start>Settings>Printers and Faxes.

& Zebra P110i USE Card Printer Y ]
Printer Document  Yiew  Help

Connect | status | owner | Pages | Sie= | Submitt=d | Part

Set As Default Printer
Printing Preferences, ..

Pause Prinking
Cancel All Documents

sharing. ..
Use Printer Offling

Propetties

Close

2. From the Printers and Faxes list, right click the P110i USB Card Printer and select
Properties from the pop-up menu. The Printer Properties window will open.

& Zebra P110i USE Card Printer Properties 2lx|
Color Management I Securiy I Device Settings
General I Sharing I Ports | Advanced

A,

@ Febra P10 LISE Card Prirter
Location: I

Comment:

Model: Zebra P110i USE Card Printer

- Features
Color: res Faper available:
Double-sided: es BEmmS4mm Card -]
Staple: Mo
Speed: Unknown
Maximum resolution: 300 dpi LI
Printing Preferences. .. | Frint Test Page |

ak. I Cancel | Lipply |

3. Onthe General tab, click on the Printing Preferences button to change the card orientation
settings, monochrome conversion settings, various ribbon settings, or to adjust the color
and head settings properties.

980515-001 Rev. C P110i & P110m Card Printer User’s Manual 15
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Printer Installation

& Zebra P110i USB Card Printer Properties g |

Calor Maragement | Security I Device Settings
General Sharing | Fots I Advanced

‘_ \_ “You can share this printer with other users on your netwark. Ta
@ enable sharing for this printer, click Share this printer.

(" Share this printer

Share name: I

= List iri the directon

Drivers

If thiz printer iz thared with uzers mwnning different wersions of
Windows, pou may want to install additional drivers, so that the
uzers do not have ta find the print driver when thep connect ta

the zhared printer.
Additional Dirivers.... |

oK I Cancel | Apply |

4. On the Sharing tab, you can choose to share the printer over the network, and install

additional driversto accommodate different operating systems.

& 7Zebra P110i USB Card Printer Properties

Color b anagement Securty Device Settings

General Sharing | Parts Advanced

c:l’lg Zebra P110i USE Card Printer

Frint to the following portfz). Documents will print to the first free
checked port.

Port Drescription Frinter

Ul COMZ Serial Por

O coM2: Serial Port

O comMa: Serial Port

O FILE:  Print to File R-Guest Flashlet series
[0 EME... ZehraEthemet inte... Zebra PE40;

firtual printer port fo... Zebra P110i USE Card Prinker
O USE... Witual printer port fo...  Zebra P330i USE Card Prinker %

[ Add Part.. ] [ Delete Port ] [ LConfigure Port. ..

Enable bidirectional support
[ Enable printer pacling

[ 0K, H Cancel ]

5. On the Ports tab, you can add, delete, and configure the printer ports, aswell as choose

which port the printer is assigned.

P110i & P110m Card Printer User’s Manual
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Printer Installation

& Zebra P110i USB Card Printer Properties x|

General | Sharing I Ports | Advanced
Color Management Security | Device Settings

&~ These settings let you azsociate color profile(z] with pour colar
printer. Color profiles control the color on your printer based on the
type of media being used and the printer configuration.

“windows will automatically select the best color profile from
the list of aszociated colar profiles [Recommended]

" Marwal  Manually sslect the default caolar prafils for all output fran
thiz device from the list of azgociated color profiles

Default color profile; <Mones

Color Profiles currently aszociated with this printer:

- |

-]

Add... Eemove | Set As Default |

oK I Cancel | Apply |

6. On the Color Management tab, you can add, remove, or change printer color profiles.

& Zebra P110i USB Card Printer Propetties x|

General I Sharing | Parts I Advanced I
Color Management Security | Device Settings

Group or uzer names:

€5 CREATOR OWMER

!ﬁ Ewveryone

m Power Usgers (01W<PTBURTOMAPower Uzers)

Add... | Bemaove |
Permizsions for Administrators Allow Deny
Frint O
Manage Printers O
ki anage Documents O
Special Permizsions [m] |

For zpecial permissions or for advanced settings, Advanced |
click Advanced. —
ak I Cancel | Apply |

7. Use the Security tab to change permissions for the printer.

980515-001 Rev. C P110i & P110m Card Printer User’s Manual
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Printer Installation

& Zebra P110i USB Card Printer Properties 21x1
Color Management | Security | Device Settings |
General I Sharing | Parts Advanced

" Available from I 12:00 AW :‘ Ta I 12:00 &M :‘

Pricrity: |1 _l;

Drriver: IZebra F110i USE Card Printer

j Mew Driver... |

& Spool print documnents so program finishes printing faster

" Start printing after last page is spocled
' Start printing jmmediately

" Prirt directly to the printer

™ Hold mismatched docurnerts
¥ Print zpooled documents first
" Keep printed documents

¥ Enable advanced printing features

Frinting Defaults... | Frint Processor... | Separator Page... |

,TI Carcel | Apply |

8. On the Advanced tab, you can choose various printer properties, install
drivers, and change default printer settings.

& Zebra P110i USB Card Printer Properties 2=

General I Sharing I Ports | Advanced |
Colar Management I Security Device Settings

gﬁ Zebra P110i Card Printer Device Settings
Printer Model/Firmware Yersion: Zebra P110i Card Printer
Encoder Settings...

Tools...
Fiw Download...

Properties. .. |

vice Information. ..

About,..

1 I+
QK I Cancel | Lpply |

different printer

9. Onthe Device Settings tab, you can change settings for a Magnetic Encoder and changeto

or from single feed mode.

10. Once the printer driver options have been configured to your satisfactiol
button to save your new configuration and close the Properties window.

P110i & P110m Card Printer User’s Manual

n, click the OK
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Printer Setup

Printer Features

The following shows an interior view of your P110i / P110m Printer.

Print
Head

o
] !
i ﬂ%
il
. =
Card = :
Output
Hopper

Ribbon
Cartridge

Lid

Card Card
Guide Feeder

19
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Printer Setup

Loading Ribbon Cartridge

The Printer requires approved ribbon cartridges. The Resin Thermal Transfer and Dye
Sublimation ribbons are specifically designed for your Printer.

* | SeriesPrintersrequirethe use of i Seriesribbonsfor full color printing.

» Each ribbon cartridge includes an integrated adhesive cleaning roller assembly that is
used to clean the cards entering the printer. Improper cleaning will reduce printer life
and degrade print quality

» When the ribbon is completely used, change the whole cartridge assembly.

Electrostatic Discharge Caution « DO NOT TOUCH the print head or the electronic
components on the print head. Discharge of electrostatic charge from the human body or other
surfaces can damage the print head or other electronic components

1. Open printer lid by pressing the Cover Release button on the top of your printer.

2. Peel protective wrapper from adhesive cleaning roller by gently pulling on the tape.
Discard the protective wrapper.

Adhesive
Cleaning
Roller

3. Insert the ribbon cartridge with the cleaning roller facing down, so the gears on the ends of the
rollersfit into the appropriate sots.
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Printer Setup
4. Closethe printer lid and push down until you hear an audible click.

Note « After thelid is closed, the ribbon automatically synchronizes when the printer power

-
i ison.

Loading Cards

To help you load, print, and collect cards, the printer has the following items:

Card Feeder

The card feeder is used for loading cards, it can hold up to 100 cards of 30 milsthickness. The
card feeder islocated under the card feeder cover of the Printer.

A Caution « DO NOT bend cards or touch print surfaces as this can reduce print quality.

Note « The surface of the cards must remain clean and dust free. Always store cardsin an

enclosed container. Ideally, use cards as soon as possible. If cards stick together, carefully

fan or shuffle them.
Note « For Cards with magnetic stripe, refer to Appendix A for loading instructions.

Load cards into card feeder as follows;

1. Open card feeder cover.
2. Slide card guide all the way to the right until it locksin place with an audible click.

Card

Feeder
Card

Guide

3. Remove cellophane wrapper from card stack.
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Printer Setup

Iy

---/

cards stuck together with significant adhesion force. These cards must be physically
separated from each other before inserting into the feeder; if not separated, feeding or
printing problems may occur.

Note « Static charges and edge burrs from the card die-cutting process can render individual

4. Holding the card deck by the sides, hold it vertically against aflat surface such asa
desktop. If the deck istoo thick for your hand to hold it comfortably, use about half a deck
at atime.

5. Push the stack back and forth to an angle of about 45° from vertical, so asto separate all of
the cards.

6. Restorethe card stack to itsoriginal squared-off condition, and place the cards in the input
hopper.

7. Place stack of up to 100 cardsinto card feeder and close the card feeder cover. When card
feeder cover is closed, the card guide locking mechanism will automatically be released.
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Printer Setup

Card Feeder Cover

Card
Stack

Card Feeder

Card Output Hopper

1. Raisethe printer lid and pull the output hopper down to placeit in its functional position.

2. When not using the printer, place the card output hopper back in its closed position to
protect the printer from dust.

Card
Output
Hopper

Printing a Test Card

With ribbon cartridge and cards loaded, your printer is ready to print. To check the operation of
the printer, you should print atest card.

1. Place the printer power switch in the OFF (0) position.

2. While holding down the Multi Function Button, place the printer power switch in the
ON (|) position. The LCD status window will glow blue.
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Printer Setup

Multi-
Function
Switch

Power
Switch

3. Keep pressing the Multi Function button until the SELF TEST message appearsin the

window.

4. Release the Multi Function button, and a test card will print after afew seconds.
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Printer Operation

Printing

Printing with the P110i or P110m Printer requires the Windows Printer Driver, your card
design/issuing software or printer command level programming through the printer
interface.

The Printer can be used with any Windows 2000 or Windows X P software application
program, using the drivers provided on CD with the printer. See Section 2 for instructions
on installing the Printer Driver.
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Printer Operation

Creating a Sample Card

Before you begin a new printing session, print a sample card to ensure that the cards will be
printed correctly. Follow the steps below to print your first card using the True Colours™
Card Printer Ribbon Cartridge and the Windows printer driver.

1.

2.

Go to the Microsoft Word Software.

If the printer was not selected as the default printer, go to File> Select Printer and choose
Printer from the printer names list. Close the Print dialog box.

Go to File>Page Setup.

Select the Size tab, and under Paper Size, choose Card. Under orientation, select
Landscape or Portrait.

Select the Margins tab, and set the Top, Bottom, Left and Right marginsto O (zero).

Press OK to close Page Setup window.

. The card appears on the window.

. Design a card with both black and colored text and with colored pictures similar to the

sample card shown below. (For the P110m, design a card with text and picturesin the
same monochrome color as the ribbon.)

R B B K
SAMPLE CARD

M. CHRIS JONES
SALES DIRECTOR

G http://www.zebracard.com
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Printer Operation

Printing a Sample Card

Once you completed creating your sample card, you are ready to print. Ensure your printer has
aTrue Colours™ Card Printer Ribbon Cartridge installed and there is card stock in the card

feeder. See Section 3 for instructions on installing the ribbon and loading the cards Print your

sample card as follows..

1. Select File>Print to open the Print dialogue box. Ensure the following settingsin the Print
dialogue box:
* Printer Name: - Zebra P110i Card Printer
* Print to File: - Unchecked
» Page Range: - All
*  Number of Copies:. - 1
» Coallate: - Unchecked
* Print What?: - Document
e Print; - All pagesin range
» Pages per sheet: - 1 page
» Scaleto paper size: - No scaling

Prine 2|
rinker
Mame: ;% Zebra P110i USE Card Prinker Properties |
Skakus: Idle
Tvpe: Zebra P110i USE Card Printer
where: LPT1: ™" Print to file
comment;
'age range —Copie
i all Mumber of copies: |1 5‘
i Current page  Selection
" Pages: 11 11 v Collate
I b
Enter page numbers andfor page ranges
separated by commas, For example, 1,3,5-12

a0

Print what: IDocument j Pages per shest: |1 page vl
Print: [l pages in range x| | seale to paper size: [ Scaling -
Optians. .. | Ok I Clase |

2. Click the OK button.

3. The printer will feed in acard and start printing. The data download time will vary
depending on the complexity of the card design and the processing speed of the compuiter.

4. Once the printing is completed, the card is gjected from the printer into the printed card
hopper.

5. Remove the sample card from the card output hopper and check for any discrepancies. If
the sample card is correct, your printer is to produce more cards.
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Cleaning

Cleaning System

Caution « PROTECT YOUR FACTORY WARRANTY!
The recommended maintenance procedures must be performed to maintain your
factory warranty. Other than the recommended cleaning procedures described in this

' manual, allow only Zebra authorized technicians to service the P110i or P110m
f j E Printer.

NEVER loosen, tighten, adjust, or bend, etc., a part or cable inside the printer.

NEVER use a high-pressure air compressor to remove particles in the printer.

Your Printer includes a simple cleaning system using Pre-Saturated Cleaning Cards
provided. The regular use of these cards will clean and maintain important parts of your
printer that cannot be reached: including Print Head, the Transport Rollers, and the
Magnetic Encoder Station (optional feature).

When to Clean

After approximately 1000 color cards have been printed, the printer LCD will prompt
CLEAN PRINTER, or when print quality has been degraded.

How to Clean

1. Leave power on.

2. Press and hold the Multi-Function Control Button for 5 seconds.
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Cleaning

Multi-Function

LCD Panel

Multi-Function
Control Button

Printer Path
Cleaning Card

10.

11.

12.

Feeder Cleaning

Card \

Card
Feeder
Cover

. When the cleaning cycle isinitiated, the LCD message REM OVE RIBBON THEN

CLOSE LID will display.

After theribbon isremoved and the lid is closed, the message EMPTY FEEDER THEN
CLOSE COVER will display.

If the lid is opened and closed without removing the ribbon, the REMOVE RIBBON
THEN CLOSE LID message will remain.

. Once the cover is closed, the firmware will gject any card inside the printer. The message

EJECTING CARD will display.

. The LCD will then display FEED LONG CLEANING CARD IN EXIT. When the card

sensor registers the presence of the cleaning card, the rollers should take the card into the
printer.

When the cleaning process is done, the printer will gject the cleaning card. If the card
sensor still sensesthe cleaning card, the message REMOVE LONG CLEANING CARD
will display.

Once the long cleaning card is no longer sensed by the exit card sensor, the message

INSERT FEEDER CLEANING CARD will display. Open the feeder cover and insert
the feeder cleaning card.

When the feeder cleaning card has been sensed by the feeder card sensor, the message
CLOSE FEEDER COVER will display.

When feeder cleaning is complete, the message REM OVE FEEDER CLEANING
CARD will display.

After the card is removed, the LCD will display READY. You may now reload the ribbon
and cards and continue printing.
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Cleaning

Cleaning the Print Head

Use of the cleaning cards will normally do an adequate job of cleaning the printer. However, a
separate Print head cleaning, using swabs, can remove more stubborn deposits when print
anomalies persist. To avoid deposits, only use foam-tipped swabs.

A Caution ¢ Never use a sharp object to scrape deposits from the print head. Permanent
damage to the print head will result

1. Place the printer power switch in the OFF (0) position.

2. Open printer lid by pressing cover release button and open cover fully to reveal the print
head mounted to inside of the cover.

3. Clean Print Head by moving alcohol-moistened swab tip side-to-side across Print Head
elements. Only use moderate force.

4. Allow two to three minutes for the printhead to dry before placing the printer power
switch inthe ON (|) position.

5. To reorder swabs, see the P110i or P110m Printer MediaList.
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Troubleshooting

Troubleshooting Procedures

The table below offers causes and solutions to symptoms related to improper operation.
Check the table when experiencing any loss of operation or print quality.

Problem / Description

Cause/ Solution

The LCD Panel displays OUT
OF CARDS message.

1. Check for cardsin the card
feeder. If no cards present, load
cards.

2. Press the Panel Button for 1
second. The printing job will
restart.

The LCD Panel displays OUT
OF RIBBON message.

1. Check ribbon. Replace if
defective or entirely used.
Ribbon will automatically
synchronize and printing will
restart with anew card.

The LCD Panel displays PRINT
HEAD OPEN message.

1. Check that Print Head Carriage
isclosed and latched. If not, close
and latch it.

980515-001 Rev. C
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Troubleshooting

The LCD Panel displays 1. Check that you are using the
MECHANICAL ERROR correct card type (see Section 7).
message. 2. If two cards are fed into the

printer at the same time:

Open cover and remove Card
Cleaning Cartridge, empty
the Card Feeder, and pull the
jammed cards out. Replace
the Card Cleaning Cartridge.

Remove cards from Card
Feeder, separate them as
shown in Loading Cardsin
Section 3, and replace.
3. Check that ribbon is loaded
correctly.

The LCD Panel displays 1. Check that you are using the
ENCODING ERROR message.  jcorrect magnetic card type (for
low or high coercivity encoding).
2. Verify command syntax.

3. Contact Zebra technical
support.

The LCD Panel displays 1. Printer cleaning required (see
CLEAN PRINTER message. Section 4).

Print Quality Issues

This section will help you resolve print quality problems The print quality is dependent on
several factors. The two most important factors that will increase your print quality are
cleanliness and card stock. To diagnose and fix print quality problems, follow the
troubleshooting procedures below:
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Example « Small spots appear on the printed card with a non-printed area or a different color.

7

Possible Cause:
» Contamination on the card surface
Solutions:
» Check that cards are stored in a dust free environment
e Useadifferent supply of cards
Possible Cause:
e Cleaning roller not installed
» Dust inside the printer and/or dirty Cleaning Roller
Solutions:
» Perform aCleaning of the printer (see Section 5)
» Check that the protective cover was removed from the ribbon cartridge cleaning roller
(see Section 3).
« If printing one card at atime, replace the cleaning roller located at the front of the
printer (see Appendix B).
Example ¢ There are non-printing horizontal lines (white) on the card surfaces.

7

_

_

7/

Possible Cause:
* Ribbon cartridge is not correctly positioned.
Solutions:
» Ensurethat the ribbon is properly rolled onto the ribbon cores of the cartridge and that
there are no wrinkles in the ribbon.
* Replace ribbon cassette.
Possible Cause:
* Print Head is dirty.
Solutions:
* Clean the Print Head
Possible Cause:
» Print Head elements are damaged (e.g., scratched or burnt).
Solutions:
e Call Zebra Customer Service for Print Head replacement information.
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Troubleshooting

Example ¢ Printing shows very pale or inconsistent results.

7

Possible Cause:

* Ribbon cartridge have been stored improperly or is damaged.
Solution:

» Change ribbon cartridge and print again.
Possible Cause:

» Cards may not meet specifications
Solution:

e Useadifferent supply of cards.
Possible Cause:

» Contrast and/or Intensity may be set to values which are too high.
Solution:

» Adjust Contrast and/or Intensity values in software.
Possible Cause:

e Dust or embedded contamination on elements of the Print Head.
Solution:

» Perform aCleaning of the Print Head (see Section 4).
Example ¢ Printing shows blurry printed image.

A

Possible Cause:

* Ribbon cartridge may not be correctly positioned.
Solution:
» Check that the ribbon is properly rolled onto the ribbon cores of the cartridge, withno
wrinkles.
» Replace ribbon cartridge, making sure it locks in place, and print again.
Possible Cause:
* Ribbon may not be synchronized on the correct color panel position (model P110i

only).
Solution:

» Openlid, then close lid to synchronize ribbon.
Possible Cause:

» Cards may not meet specifications.
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Solution:

e Useadifferent supply of cards.
Possible Cause:

» Dust or embedded contamination inside the printer and/or dirty Cleaning Roller.
Solution:

» Clean the Print Head.
* Replace Cleaning Roller.

Example ¢ No printing on the card.

Possible Cause:

* Ribbon cartridge may not be installed in the printer.
Solution:

» Check for ribbon cartridgein the printer.
Possible Cause:

» Cards may not meet specifications.
Solution:

e Useadifferent supply of cards.
Possible Cause:

» Cable on Print Head may be disconnected.

» Print Head elements may be scratched or burnt.
Solution:

» Call Servicefor Print Head repair or replacement information.

Troubleshooting the Ethernet Connection and Adapter

Resetting to Factory Defaults

To reset the Ethernet Adapter configuration parameters to the factory defaults, press the
Ethernet Switch

and hold it in while turning the printer power on. Keep the Panel Button pressed until the
Status Indicator light turns green, then rel ease the Ethernet Switch. To print a configuration
card, press and hold the Ethernet Switch until a card startsto print.
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Ethernet Adapter Status Indicator

A bi-color Status Indicator displays the operational status of the Ethernet Adapter.The
following conditions might occur:

1. During normal operation, the LED issolid for more than 30 seconds. Thisindicates
al the hardware is functioning properly and the Ethernet Adapter has detected the
presence of the network. It does not mean the Ethernet Adapter has an IP address or is
attached to a printer queue.

2. If the LED israpidly flashing (9 times/sec), the Ethernet Adapter has not detected
the presence of a network cable. To solve the problem:

» Verify that the network cable is appropriate for the network and has an RJ-45
connector.

e Turn the printer power off (O). Remove the network cable from the Ethernet Adapter.
Plug the network cable back in until you hear a positive click. Check the other end of
the cable in the same manner. Turn the printer power on; if the Ethernet Adapter still
does not detect a cable, continue.

¢ Connect the Ethernet Adapter to a known good network connection. If the Ethernet
Adapter is still unable to detect the network cable, contact Technical Support for
assistance.

Important « Cables with arating higher than CAT-6 have not been tested.

3. If the LED isslowly flashing green (1 time/sec), the Ethernet Adapter istrying to print a
job. If the job does not print, check the following:
* Verify that the printer has media and ribbon. If the printer is showing any errors, it is
unlikely that the Ethernet Adapter can send datato the printer. The LED continues to
blink until the printer malfunction is resolved or until the printer is turned off (O).

» Fashing red indicates the Power On Self Test (POST) isin progress.

4. If the LED is solid red for more than 30 seconds, the Ethernet Adapter has failed the
POST. A failed POST can be caused by any of the following:
« The printer attached to the Ethernet Adapter device is mafunctioning. Turn the
printer power off, wait 10 seconds, then turn the printer back on (| ).
 If the Ethernet Adapter still failsthe POST, the Ethernet Adapter has a hardware
problem that can be fixed only by replacing or returning the unit. Contact Technical
Support for repair or replacement information.

5. If the LED isdternately flashing red and for longer than 2 minutes, the Ethernet
Adapter isin firmware-download mode. This meansit iswaiting for new firmware datato
be sent before it continues normal functioning. Perform the following:

« If the Ethernet Adapter was purposely put into firmware-download maode, finish the
download with the proper update utility. Contact the Zebraweb site at
http://www.zebra.com to download this utility.

¢ Contact Technical Support for help recovering this unit.
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Troubleshooting

Network Status/Activity Indicator
A bi-color Status/Activity LED indicates network speed, established link, and network

activity.
1. If the LED is off, no link was established.
2. If the LED is solid , a100Base link is established.
3. If the LED isflashing , 2a100Base link is established and network activity has been
detected.
4. If the LED issolid orange, a10Baselink is established.
5. If the LED isflashing or ange, a 10Base link was established and network activity has

been detected.

Network activity detected by this LED does not mean the activity is data for the print server.
The activity is al activity on the network seen on the Ethernet Adapter.

980515-001 Rev. C

P110i & P110m Card Printer User’s Manual 39



40

P110i & P110m Card Printer User’s Manual

980515-001 Rev. C



-

Technical Specifications

General
e Load-N-Go™ drop-in ribbon cartridge

e 16-digit LCD display
e Windows® driversfor 2000 and XP

Color Printing
e Color dye sublimation or monochrome thermal transfer printing (P110i);
Monaochrome thermal transfer printing only (P110m)

» 30 seconds per card full color single sided (Y MCKO) (P110i only)
* 300 dpi (11.8 dotsYmm) print resolution

Bar Code
» Code 39, Code 128 B & C with & without check digit
e 20f5& 2of 5Interleaved
» UPC-A,EAN8& EAN 13
* PDF-417 2D bar code and other symbologies can be printed via
Windows drivers
Cards

« Types. PVC, PVC Composite

e Card width/length: ISO CR-80-1SO 7810, 2.12" (54mm) x 3.38" (86mm)
* Magnetic Stripe-I SO 7811

e  Smart Card-1SO 7816

e Card thickness: 30 mil (.76mm) (+/- 10%)

»  Card feeder capacity: 100 cards (30 mil)

»  Card output hopper capacity: 45 cards (30 mil)
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Ribbons Cartridges
» Load-N-Go™ ribbon cartridge with integrated card-cleaning roller

» | Seriestechnology featuring contact-chip-based ribbon detection (P110i
only)
*  YMCKO: 200 cards/cartridge (P110i only)

*  Monochrome: 1000 cards/cartridge in black or blue; 850 cards/cartridge

white

Interfaces

* USB 1.1 (cableincluded)

e USB 1.1 and built-in Ethernet (optional)
Dimensions

e Width: 7.9in (201mm)

» Depth: 12.9in (328mm)

e Height: 8.5in (216mm)

*  Weight: 9.5 Ibs (4.3kg)
Electrical

e 110~ 240 Volts AC, 50 ~ 60 Hz (auto switching)
e 8 MB image memory standard
» FCCClassA, CE, UL and CUL approved

Environmental
*  Operating Temperature: 60°F to 86°F (15°C to 30°C)

*  Operating Humidity: 20% to 65% non-condensing
e Storage Temperature: 23°F to 158°F (-5°C to 70°C)
»  Storage Humidity: 20% to 70% non-condensing

e Ventilation: Free air

Options
» Magnetic encoder (30 mil cards only), 3 track HiCo/LoCo

*  CardSense™ single card-feed mode
e P110i Starter Kit (200 cardsand 1 YMCKO ribbon)
» Cleaning Kit (1 cleaning card and 1 cleaning swab)
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Card Dimensions

ISO standard dimensions for plain card

( \

2.125 £ 0.002in
(53.98 £ 0.050mm)

| J

lee—— 3.375+0.010in ——p»]

Radius (85.72 + 0.25mm)
0.125in
(3.18mm)
0.009 ~ 0.034in

— | -

(0.23 ~ 0.84mm)

ISO standard dimensions for magnetic stripe card

1 1

\ 0.218in (5.54mm) max

MAGNETIC STRIPE

0~0.115in (2.92mm) , » ‘ 0~0.115 in (2.92 mm)
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Appendix A

Magnetic Card Encoder

Introduction

This section contains information on the additional operations of the P110i or P110m
Printers with Magnetic Card Stripe Encoder.
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Magnetic Card Encoder

Media Loading Orientation

stripe cards. The magnetic stripe must be flush to the surface of the card to work properly.

Caution « ONLY USE cards that comply with ISO 7810 & 7811 standards for magnetic
A Never use cards which have taped-on magnetic stripes.

The magnetic encoder is afactory installed item with the read/write head positioned below or
above the card path, available with HiCo or LoCo encoding.

When loading cards with magnetic stripesinto the card feeder, please ensure that the magnetic
stripe is facing the | eft side of the printer, and closest to the bottom edge of the card feeder, as
shown bel ow.

Magnetic
Stripe

Note « Zebra approved HiCo & LoCo PV C cards are available.

Magnetic Encoder Cleaning

Use the standard cleaning card process as described in Section 5. This cleans the most

important parts of the printer; including the Print Head, Transport Roller, and Magnetic Stripe
Encoder.
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980515-001 Rev. C

Magnetic Card Encoder

Track # Field Track Valid # of
Separator Density Characters characters
1 A 210 BPI* Alphanumeri | 79%
c (ASCII
20~9571)
2 = 75 BPI* Numeric 40F
(ASCII
48~62)
3 = 210 BPI* Numeric 107F
(ASCII
48~62)
*Bits per inch

TExcept the “?’ character

Fincluding Start, Stop, and LRC characters. Also note that these 3
characters areautomatically managed by the magnetic encoder according

to the ISO Standard Norms.

P110i & P110m Card Printer User’s Manual

Note « Refer to the Card Printer Programmer’s Manual for complete programming
information.
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Appendix B

Card Sense™ Single Card
Feed Mode

Printing a Single Card Without Using the Feeder

For operating the P110i or P110m Card Printer in single card feed mode, the printer
requires that the operator install an optional Card Sense™ Single Card Feed Kit. In Single
Card Feed Maode, the printer will only accept cards through the front slot, not from the card
feeder.

Install Card Sense™ Single Card Feed Kit

i

1. Set printer to OFF.
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Card Sense™ Single Card Feed Mode

Ribbon
Cartridge

Printer /

Lid

2. Open the lid and remove the ribbon cartridge.

Important » Make sure the output hopper remains closed.

Roller from
Single Card
Feed Kit

i

:,1!;\\

3. Install the black roller from the Single Card Feed Kit into the blue tabs at the front of the
printer, and press roller down firmly to lock into the tabs.

Install Card Cleaning Cartridge

Install the Card Cleaning Cartridge as follows:
1. Open thelid of the card cleaning cartridge.
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Card Sense™ Single Card Feed Mode

card /

Cleaning
Cartridge

2. Insert the cleaning roller into the card cleaning cartridge and close the cartridge.

3. Peel protective wrapper from adhesive cleaning roller by gently pulling on the blue tape,
and discard the wrapper.

4. Slide the Card Cleaning Cartridge into the slots provided at the front of the printer. An
alignment tab is located on the | eft side of the Card Cleaning Cartridge to ensure proper
installation.

5. Insert the Ribbon Cartridge with the cleaning roller facing down, so the gears on the ends
of therollersfit into the appropriate sl ots.

6. Close the printer lid and push down until you hear an audible click. If you can not close
the lid, the cleaning cartridge or the ribbon cartridge may be installed wrong.
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Card Sense™ Single Card Feed Mode

Setting Up the Printer Driver

Go to Printer Properties.

Select the Device Settings tab.
Select Single Feed Properties.
Select Enable Single Feed Support.
Click the Apply button.

o > 0N PRE

hopper. You do not have to remove the components of the Single Card Feed Kit in order to

Important « You can disable Single Feed Support and return to printing cards from the
operate in normal mode.

Printing a Single Card

1. Place the printer power switch in the ON ( | ) position.
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Card Sense™ Single Card Feed Mode

2. Insert asingle card into the slot at the front of the printer, directly above the card output
hopper. Do not feed more than one card at atime. Printer will take the card.
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Appendix C

Connecting to a Network

Card printers can be connected to an Ethernet network in three ways.

Printer Sharing

In printer sharing, the printer is connected locally to the host computer and configured to

be shared to other client computers. Client computers connect to the printer over the
network through the host computer.

- - I
HE
-
:
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Connecting to a Network

External Print Server

A stand aone device that acts as a server on the network specifically for receiving print jobs
and passing them to the printer. Client computers connect to the print server over a network.

Internal Print Server

Similar to an external print server, except the print server isintegrated into the printer. This
removes the need for a separate power supply and separate device drivers. Thisis the simplest
way to network a printer.
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Appendix D
Worldwide Sales & Support

Sales and Support Locations

North America:

Zebra Technol ogies Card Printer Solutions
1001 Flynn Road

Camarillo, CA 93012-8706 USA

Phone: + 1 (805) 579 1800

Fax: + 1 (805) 579 1808

e-mail: cards@zebra.com

Europe, Middle East, and Africa:

Zebra Technol ogies Card Printer Solutions
The Valley Centre, Gordon Road

High Wycombe

Buckinghamshire HP13 6EQ

United Kingdom

Phone: + 44 (0) 870 241 1527

Fax: + 44 (0) 870 241 0765

e-mail: eurosales@zebra.com
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Worldwide Sales & Support

Asia Pacific:

Zebra Technol ogies Card Printer Solutions
120 Robinson Road

#06-01 Parakou Building

Singapore 068913

Phone: + 65 6858 0722

Fax: + 65 6885 0836

e-mail: asiasales@zebra.com

Latin America:

Website
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Zebra Technol ogies Card Printer Solutions
9800 NW 41st Street, Suite 220

Dord, FL 33178 USA

Phone: + 1 (305) 558 3100

Fax: + 1 (305) 558-8485

e-mail: |atinsales@zebra.com

www.zebracard.com

P110i & P110m Card Printer User’s Manual

980515-001 Rev. C


mailto:asiasales@zebra.com
mailto:asiasales@zebra.com
mailto:latinsales@zebra.com

mailto:latinsales@zebra.com
mailto:latinsales@zebra.com
mailto:latinsales@zebra.com
http://www.zebracard.com
http://www.zebracard.com
http://www.zebracard.com

	Foreword
	Copyright Notice
	Trademarks
	Product Disposal
	Return Materials Authorization
	Declarations of Conformity
	Icons
	Printer Models

	Getting Started
	Unpacking Your Card Printer
	Controls and Indicators
	Multi-Function LCD Panel
	Rear Panel Connectors, Controls, and Indicators


	Printer Installation
	Installing the P110i or P110m Printer
	Installing the Printer Driver
	Print Driver Installation

	Change Printer Driver Options
	Loading Ribbon Cartridge
	Loading Cards
	Card Feeder
	Card Output Hopper

	Printing a Test Card

	Printer Setup
	Printer Features

	Printer Operation
	Printing
	Creating a Sample Card
	Printing a Sample Card


	Cleaning
	Cleaning System
	When to Clean
	How to Clean

	Cleaning the Print Head

	Troubleshooting
	Troubleshooting Procedures
	Print Quality Issues

	Troubleshooting the Ethernet Connection and Adapter
	Resetting to Factory Defaults
	Ethernet Adapter Status Indicator
	Network Status/Activity Indicator


	Technical Specifications
	Card Dimensions
	ISO standard dimensions for plain card
	ISO standard dimensions for magnetic stripe card


	Magnetic Card Encoder
	Introduction
	Media Loading Orientation
	Magnetic Encoder Cleaning
	ISO Standard Encoding


	Card SenseTM Single Card Feed Mode
	Printing a Single Card Without Using the Feeder
	Install Card SenseTM Single Card Feed Kit
	Install Card Cleaning Cartridge

	Printing a Single Card

	Connecting to a Network
	Printer Sharing
	External Print Server
	Internal Print Server

	Worldwide Sales & Support
	Sales and Support Locations
	Website


